
Getting Started with the
TI-Nspire™ CX/

TI-Nspire™ CX CAS
Handheld

This guidebook applies to TI-Nspire™ software version 3.2. To obtain the 
latest version of the documentation, go to education.ti.com/guides.

http://www.education.ti.com/guides


ii

Important Information
Except as otherwise expressly stated in the License that accompanies a 
program, Texas Instruments makes no warranty, either express or 
implied, including but not limited to any implied warranties of 
merchantability and fitness for a particular purpose, regarding any 
programs or book materials and makes such materials available solely on 
an "as-is" basis. In no event shall Texas Instruments be liable to anyone 
for special, collateral, incidental, or consequential damages in connection 
with or arising out of the purchase or use of these materials, and the sole 
and exclusive liability of Texas Instruments, regardless of the form of 
action, shall not exceed the amount set forth in the license for the 
program. Moreover, Texas Instruments shall not be liable for any claim of 
any kind whatsoever against the use of these materials by any other 
party.

FCC Statement
Note: This equipment has been tested and found to comply with the 
limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. 
These limits are designed to provide reasonable protection against 
harmful interference in a residential installation. This equipment 
generates, uses and can radiate radio frequency energy and, if not 
installed and used in accordance with the instructions, may cause 
harmful interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular installation.

If this equipment does cause harmful interference to radio or television 
reception, which can be determined by turning the equipment off and 
on, the user is encouraged to try to correct the interference by one or 
more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from 
that to which the receiver is connected.

• Consult the dealer or an experienced radio/TV technician for help.

Modifications not expressly approved by the manufacturer could void the 
user’s authority to operate the equipment under FCC rules.

Vernier DataQuest™ is a trademark of its respective owner.

© 2010 - 2012 Texas Instruments Incorporated
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Getting Started with the TI-Nspire™ CX 
Handheld

The TI-Nspire™ CX handheld and the TI-Nspire™ CX CAS handheld are 
the newest handhelds in the TI-Nspire™ family of products. Featuring a 
backlit color display and a slimmer form, the handhelds provide 
touchpad navigation, dynamic graphing, and interactive computer 
features.

The handhelds and the TI-Nspire™ software share the same functionality, 
enabling you to transfer class assignments from the handheld to the 
computer or transfer documents to the handheld when you need to be 
mobile. Start assignments at school, and then finish the work at home to 
take advantage of the software’s full-color display and easy-to-use 
navigation. Use the software to download the latest software and 
handheld operating system updates as they become available to ensure 
you have the latest enhancements.

This guide covers both the TI-Nspire™ CX handheld and the TI-Nspire™ 
CX CAS handheld. While they operate identically in many ways, there are 
a few distinctions. If the TI-Nspire™ CX CAS handheld has additional 
functionality, it is pointed out and the CAS operation is described.

About CAS
With CAS, or the Computer Algebra System, you can: 

• Perform both symbolic and numeric calculations. 

• Factor and expand expressions and solve for common denominators.

TI-Nspire™ CAS technology makes it possible to recognize, simplify, and 
calculate math expressions, preserving the symbols including variables 
and terms such as “e” and p.

This ability to enter and view equations and expressions on screen as they 
appear in textbooks is especially useful for step-by-step, arithmetic, 
algebraic, and calculus calculations.
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TI-Nspire™ CX Handheld Keys

d Removes menus 
or dialog boxes from 
the screen. Also stops 
a calculation in 
progress.

Use the TI-Nspire™ Touchpad as you would a laptop 
touchpad. You can also press the outer edges to move right, 
left, up, and down.

» Opens the 
Scratchpad for 
performing quick 
calculations and 
graphing.

e Moves to the 
next entry field.

g Makes the next 
character typed 
upper-case.

/ Provides access 
to the function or 
character shown 
above each key. Also 
enables shortcuts in 
combination with 
other keys.

c Turns on the 
handheld. If the 
handheld is on, this 
key displays the home 
screen.

~ Opens the 
Document menu.

b Displays the 
application or context 
menu.

. Deletes the 
previous character.

h Displays stored 
variables.

· Evaluates an 
expression, executes 
an instruction, or 
selects a menu item.

Note: A ¢ symbol on a key indicates access to multiple options. To access an option, 

press º repeatedly or use the arrow keys on the Touchpad. Press · or click to 
select the option.
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Preparing the TI-Nspire™ CX Handheld for Use
The TI-Nspire™ CX handheld comes equipped with an Li-ion 
rechargeable battery. Like a cell phone or other similar device, charge the 
battery for at least four hours to ensure optimum performance. The 
handheld also comes with the following accessories:

• Standard mini-B to mini-B USB cable for transferring files to another 
handheld

• Standard A to mini-B USB cable for transferring files to and from a 
computer and for charging the battery

Charging the Handheld
Use one of the following options to charge the battery in the TI-Nspire™ 
CX handheld:

• Connect the handheld to a computer using a standard A to mini-B 
USB cable. If the driver is not found when the handheld is connected 
to the computer, insert the CD to install the correct driver. To 
download software that includes a driver, go to 
education.ti.com/software.

• Connect to a wall outlet using a TI wall adapter (sold separately in 
Europe and Asia). 

• Place the handheld or multiple handhelds in a TI-Nspire™ CX Docking 
Station or TI-Nspire™ Docking Station.

Note: For more information about recharging batteries, see Configuring 
Handhelds.

Turning On the TI-Nspire™ Handheld for the First 
Time

 After charging the battery, press c to turn on the handheld.

A progress bar is displayed while the operating system loads. Next, 
choose preferences for language and font size when prompted.

Note: To turn the handheld off, press / c. The settings and 
memory contents are retained.
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Using Automatic Power Down™ 
To prolong battery life, the Automatic Power Down™ (APD™) feature 
turns off the handheld after three minutes of inactivity. When this 
happens, press c to turn the handheld on and return to the last 
document or last menu accessed. To change the default setting, press 
c 5 3 to access the Handheld Setup screen where you can change 
the Power Standby setting.

Note: For more information about setting up the handheld, see 
Configuring Handhelds.

Choosing a Language
After the OS is loaded, select a preferred language.

1. Press ¢ to open the drop-down list.

2. Press 6 to scroll through the languages, and then press x or ·  
to select a language.

3. Press e to highlight the OK button, and then press x or · to 
save the language selection.

Choosing a Font Size
Next, select a font size for the display.

1. Press ¢ to open the drop-down list.
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2. Press 6 to highlight the font size, and then press x or · to select 
it.

3. Press e to highlight the OK button, and then press x or ·.

The Welcome! screen opens.

4. To continue, press x or · to select OK. 

The Home screen opens. 

Adjusting the Brightness of the Backlighting
The screen on the TI-Nspire™ CX handheld is backlit making it easier to 
use in all lighting conditions. By default, the brightness setting is 
medium. To adjust the backlight brightness:

• Dimmer: Press and hold / and tap -.

• Brighter: Press / and tap +.

Using the TI-Nspire™ Touchpad
Use the Touchpad to navigate or complete any task that can be 
completed using the arrow and Enter keys. Use the Touchpad to navigate 
in two ways: 



6 Getting Started with the TI-Nspire™ CX Handheld

• Use it like a computer touchpad by moving your fingertip in a sliding 
motion on the center area of the Touchpad to activate and move the 
mouse pointer. Click or tap the center of the Touchpad to select a 
menu option or complete an action. 

• Press the arrow keys on the outside edge of the Touchpad to nudge 
the mouse pointer up, down, left, or right, and then click e x or 

press · to complete an action. 

If you hold down an arrow key, the mouse pointer continues to move 
in that direction.

Note: If the mouse pointer is visible on a command or file, click or 
tap x in the center of the Touchpad to select that command or file. If 
the command or file is highlighted, move the pointer over that item or 
press · to select it.

When working in an application, use the Touchpad to access more 
information about problems. For example, hovering over a Graphs & 
Geometry object displays information about variables used in that object 
and about tools that are available.

Some users prefer to customize their Touchpad settings; to speed up or 
slow down their pointer, or to enable tap to click. To change the default 
settings for the Touchpad, see Configuring Handhelds.

Understanding the Scratchpad
Use the Scratchpad to make quick calculations and graphs without 
affecting the current TI-Nspire™ document. For example, when you need 
a quick way to test a calculation before you add it to a document, you 
can open the Scratchpad application and perform the calculation. Then, 
you can either discard the calculation or add it to a document. For more 
information about the Scratchpad, see Using the Scratchpad.

Using the Home Screen
The Home screen provides a starting point for all activities performed on 
a handheld:

• Opening the scratchpad for quick calculations and graphing

• Creating new documents

• Opening and managing existing documents

• Opening the scratchpad for quick calculations and graphing

• Defining settings and viewing status

• Viewing hints for operating the handheld
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• Accessing recent documents

• Returning to the current document

Note: To return to the Home screen from any other location, press c.

Home Screen Options

Menu Option Purpose

Scratchpad

Use the Scratchpad menu options to open a Calculator or Graph 
application without affecting your document.

While in Scratchpad, press » to toggle between Scratchpad 
applications: Calculate and Graph.

Calculate Opens the Scratchpad with a Calculator application 
active. From the Home screen, type A.

Graph Opens the Scratchpad with a Graph application 
active. From the Home screen, type B.

Documents

To select options for working with documents, press the associated 
number or use the Touchpad to select an icon then press x or ·.

New 
Document

Opens a new TI-Nspire™ document with available 
applications listed.

My 
Documents

Opens the file browser where you can open existing 
TI-Nspire™ documents or send files to others.

Recent Lists the five most recently saved documents.

Current Goes to the document that is currently open.

Settings Check the status of the handheld and change 
settings.

Application icons

To add a new page to the current document, select an application 
icon. If no document is open, a new document opens with the 
selected application on a new page.
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To learn more about applications and documents, see the Working with 
Documents on the TI-Nspire™ handhelds.

Calculator Adds a page to a document for entering and 
evaluating math expressions.

Graphs Adds a page for graphing and exploring functions.

Geometry Adds a page for creating and exploring geometric 
shapes.

Lists & 
Spreadsheet

Adds a page for working with data in tables.

Data & 
Statistics

Adds a page and provides tools used to visualize 
sets of data in different types of plots and provides 
tools for manipulating data sets to explore 
relationships between the sets of data.

Notes Provides text editing functions for adding text to 
TI-Nspire™ documents for use as notes or to share 
with other users.

Vernier 
DataQuest™

Adds a page for collecting and analyzing data from 
sensors or probes.

Menu Option Purpose
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The TI-Nspire™ Handheld Screen
The icons on the handheld screen provide information about the status 
of handheld operations and provide an easy way to access and change 
settings. This screen shows the icons, which are described below.

 

Icon Function

À 3 4 Page scrolling arrows - Use the touchpad and these 
arrows to scroll through the pages in a document.

Á Page tabs - Indicate the problem number followed by 
the page number. If problems are named, move the 
Touchpad pointer over the tab to view the page name.

Â Document name - Shows the current document name. 
Click here to access the Documents menu. An asterisk by 
the document name indicates changes were made since 
the document was last saved.

Ã Press to Test - Indicates that the handheld is in Press-to-
Test mode.

Ä Login status - Shows whether the handheld is searching 
for an access point (blinking), found an access point 
(solid), not communicating, connected and ready to log 
in (a blinking arrow), or logged in and charged (a solid 
arrow). Click here to view Settings & Status.

Å g, /, or Ê status.
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Using Hints
Hints are quick tips available throughout the software on the handheld. 
There are several easy ways to access Hints:

• Press / μ.

• Some dialog boxes contain a question mark icon. Click this icon to 
open Hints for that task.

 To scroll through the Hints, use the Touchpad or arrow keys:

– To page down, press / 3.

– To page up, press / 9.

– To go to the end of the Hints file, press / 1.

– To go back to the beginning of the file, press / 7.

Æ Settings & Status:

• Hover the cursor over the icon to show the angle 
mode setting in effect for the active application and 
the level of the battery supply.

• Click the icon to open the Settings menu.

Ç Close document - Click here to close the current 
document. If information is unsaved, save or discard 
when prompted.

Icon Function
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Using the Scratchpad

The Scratchpad is a feature of the TI-Nspire™ CX handheld that lets you 
quickly:

• Evaluate math expressions.

• Graph functions.

Opening and Closing the Scratchpad

 From the Home screen, press » to open the Scratchpad.

The first time you open the Scratchpad, a blank page opens with the 
Calculator active.

 Press » to alternate between the Calculate and Graph pages.
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 Press b to see the Scratchpad Calculate or Scratchpad Graph menu. 
These menus are subsets of the TI-Nspire™ menus for the Calculator 
and Graphs applications. For complete listings of those menus, see 
the documentation for those applications.

 Press d to close the Scratchpad.

Calculating with Scratchpad
From the Scratchpad Calculate page, enter a math expression on the 
entry line, and then press · to evaluate the expression. Expressions 
are displayed in standard mathematical notation as you enter them.

Each evaluated expression and result becomes part of the Scratchpad 
history, displayed above the entry line. 

Entering Simple Math Expressions

Note: To enter a negative number, press v and then type the number.

Suppose you want to evaluate  

1. Select the entry line in the work area.

2. Type 2 l 8 to begin the expression.

3. Press ¢ to return the cursor to the baseline, and then complete the 
expression by typing:
r 43 p 12

4. Press · to evaluate the expression.

The expression is displayed in standard mathematical notation, and 
the result is displayed on the right side of the page.
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Note: You can force a decimal approximation in a result by pressing 
/ · instead of ·.

Note: Results formatting can also be adjusted in settings. For more 
information about customizing settings, see Configuring Handhelds.

Inserting Items from the Catalog
You can use the Catalog to insert functions and commands, symbols, and 
expression templates into the entry line.

1. Press k to open the Catalog. By default, the first tab is displayed, 
which lists all commands and functions in alphabetical order.

Pressing / · forces the approximate result.

Catalog for a 
non-CAS 
handheld
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2. If the function you are inserting is visible in the list, select it and press 
· to insert it.

3. If the function is not visible:

a) Press a letter key to jump to the entries that begin with that letter.

b) Press ¤ or £ as necessary to highlight the item you are inserting.

c) Click a numbered tab to list functions by category: math functions, 
symbols, math templates, library objects, and value for standard 
measurement units (CAS).

d) Press · to insert the item into the entry line.

Using an Expression Template
Templates help you enter matrices, piecewise functions, systems of 
equations, integrals, derivatives, products, and other math expressions.

For example, suppose you want to evaluate 

1. Press t to open the Template palette.

2. Select  to insert the algebraic sum template.

The template appears on the entry line with small blocks representing 
elements that you can enter. A cursor appears next to one of the 
elements to show that you can type a value for that element.

Catalog for a 
CAS handheld
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3. Use the arrow keys to move the cursor to each element’s position, and 
type a value or expression for each element.

4. Press · to evaluate the expression.

Inserting Expressions Using a Wizard
You can use a wizard to simplify entering some expressions. The wizard 
contains labeled boxes to help you enter the arguments in the 
expression.

For example, suppose you want to fit a y=mx+b linear regression model 
to the following two lists:

{1,2,3,4,5}
{5,8,11,14,17}

1. Press k 1 to open the Catalog and show the alphabetic list of 
functions.

2. Click inside the list, and then press L to jump to the entries that 
begin with “L.”

3. Press ¤ as necessary to highlight LinRegMx.

4. If the Wizards On option is not checked, press e e to highlight 
Wizards On.

5. Press · to change the setting.
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6. Press e e to highlight LinRegMx again.

7. Press ·.

A wizard opens, giving you a labeled box to type each argument.

LinRegMx 
function in a 
non-CAS 
handheld

LinRegMx 
function in a 
CAS handheld
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8. Type {1,2,3,4,5} as X List.

9. Press e to move to the Y List field.

10. Type {5,8,11,14,17} as Y List.

11. If you want to store the regression equation in a specific variable, 
press e, and then replace Save RegEqn To with the name of the 
function variable (f1 through f99).

12. Click OK to close the wizard and insert the expression into the entry 
line.

The expression is inserted along with statements to copy the 
regression equation and display the variable stat.results, which will 
contain the results.

LinRegMx {1,2,3,4,5},{5,8,11,14,17},1: CopyVar stat.RegEqn,f1: 
stat.results

The Scratchpad then displays the stat.results variables.

Note: You can copy values from the stat.results variables and paste 
them into the entry line.

Viewing the History
Each evaluated expression and result becomes part of the Scratchpad 
history, displayed above the entry line. 

 Press £ or ¤ to scroll through the history.
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Copying a History Item to the Entry Line
You can quickly copy an expression, subexpression, or result from the 
history into the entry line.

1. Press £ or ¤ to move through the history and select the item that 
you want to copy.

2. Optionally, select part of the expression or result by using g in 
combination with the arrow keys.

3. Press · to copy the selection and insert it into the entry line.

Clearing the History
When you clear the history, all variables and functions defined in the 
history retain their current values. If you clear the history by mistake, use 
the undo feature.

 From the Actions menu, click Clear History.

—or—

À Current entry/total entries
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Press b 1 5.

All expressions and results are removed from the history.

Editing Scratchpad Expressions
Although you cannot edit a Scratchpad Calculate expression in the 
history, you can copy all or part of an expression from the history and 
paste it to the entry line. You can then edit the entry line.

Inserting Elements into the Entry Line

1. Press e, ¡, ¢, £, or ¤ to position the cursor in the expression. 

The cursor moves to the closest valid position in the direction that you 
press.

2. Type the elements or insert them from the Catalog.

Selecting Part of an Expression
You can delete, cut, or copy a selected part of an expression.

1. Press ¡, ¢, £, or ¤ to move the cursor to a starting point in the 
expression.

2. Press and hold g and press ¡, ¢, £, or ¤ to select.

– To delete the selection, press ..

– To cut the selection to the Clipboard, press / X.

– To copy the selection to the Clipboard, press / C.

– To paste the selection to a new entry line in Scratchpad, press 
/ V.

Graphing with the Scratchpad

1. Press » to open the Scratchpad Graph page if it is not already 
open.

By default, the entry line is displayed. The entry line displays the 
required format for typing a relation. The default graph type is 
Function, so the form f1(x)= is displayed. 

If the entry line is not shown, press Ctrl + G or press b 2 3 to 
display the entry line and type an expression to graph.

2. Press b > Graph Entry/Edit and select a graph type.

For example:
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• To graph an equation for a circle, press b > Graph Entry/Edit > 

Equation > Circle > (x-h)2 + (y-k)2 = r2 or press b 3 2 3 1. 

Fill in the equation and press · to draw the circle.

• To graph a function, press b > Graph Entry/Edit > Function or 

press b 3 1.

The entry line changes to display the expression format for the 
specified graph type. You can specify multiple relations of each graph 
type.

3. Type an expression and any other parameters required for the graph 
type.

4. Press · to graph the relation, or press ¤ to add another relation. 

If necessary, you can use press b 4 to choose a tool on the 
Window/Zoom menu and adjust the viewing area.

When you graph the relation, the entry line disappears to show an 
uncluttered view of the graph. If you select or trace a plot, the 
relation that defines the plot is displayed on the entry line. You can 
modify a plot by defining a relation or by selecting and changing the 
graph.

As you graph multiple plots, the defining relation is displayed for 
each. You can define and graph a maximum of 99 relations of each 
type. 

5. Use the b key to explore and analyze the relation to:

• Trace the relation.

• Find points of interest.

• Assign a variable in the expression to a slider.

Viewing the Table
 To display a table of values corresponding to the current plots, press 

b > Table > Split-screen Table (b 7 1).
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 To hide the table, click the graph side of the split screen, and then 
press b > Table > Remove Table (b 7 2). You can also press 
Ctrl + T.

 To resize columns, click the table and press b > Actions > Resize 

(b 1 1).

 To delete a column, edit an expression, or edit table settings, click the 
table and press b > Table (b2).

Changing the Appearance of the Axes
As you work with graphs, the Cartesian axes are displayed by default. 
You can change the appearance of the axes in the following ways:

1. Press b 4 and choose the Zoom tool to use. 

2. Select the axes and press / b 2 to activate the Attributes tool.

a) Press £ or ¤ to move to the attribute to change. For example, 
choose the end style attribute.

b) Press ¡ or ¢ to choose the style to apply. 

c) Change any other attributes of the axes as required for your work, 
and then press · to exit the attributes tool.

3. Adjust the axes scale and tic mark spacing manually. 

a) Click and hold one tick mark, and move it on the axis. The spacing 
and number of tic marks increases (or decreases) on both axes.

b) To adjust the scale and tic mark spacing on a single axis, press and 
hold g, and then grab and drag a tic mark on that axis.
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4. Change axis end values by double-clicking them and typing new 
values.

5. Adjust the location of the axes. To move the existing axes without 
resizing or rescaling them, click in and drag an empty region of the 
screen until the axes are in the desired location. 

6. Change the axes’ scales by pressing b > Window/Zoom > Window 

Settings (b 4 1). 

Type the values of your choice over the current values for x-min, 
x-max, y-min, y-max, Xscale, and Yscale and click OK. 

7. Press b > View > Hide Axes (b 2 1) to hide or show the axes.

• If the axes are shown on the page, selecting this tool hides them.

• If the axes are hidden on the page, selecting this tool redisplays 
them.

Tracing a Plot
Graph Trace moves through the points of a graphed function, 
parametric, polar, sequence, or scatter plot. To enable the trace tool:

1. Press b > Trace > Graph Trace (b 5 1) to move across the 
plot in Trace mode.

2. (Optional) To change the trace step increment for tracing, press 
b 5 3.

After you type a different step increment, the Graph Trace tool moves 
across the graph in steps of that size.

3. Use Graph Trace to explore a plot in the following ways: 

• Move to a point and hover to move the trace cursor to that point.
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• Press ¡ or ¢ to move from point to point on the function’s graph. 
The coordinates of each point traced are displayed.

• Press £ or ¤ to move from one plot to another. The point’s 
coordinates update to reflect the new location of the trace. The 
trace cursor is positioned on the point of the new graph or plot 
with the closest x value to the last point identified on the 
previously traced function or graph. 

• Type a number and press · to move the trace cursor to the 
point on the plot with independent coordinates nearest the typed 
value. 

• Create a persistent point that remains on the graph by pressing 
· when the trace point reaches the point you want to label. 
The point remains after you exit Graph Trace mode.

Notes: 

• The string undef is displayed instead of a value when you move 
over a point that is not defined for the function (a discontinuity).

• When you trace beyond the initially visible graph, the screen pans 
to show the area being traced.

4. Press d or choose another tool to exit Graph Trace.

Finding Points of Interest
You can use the tools on the Analyze Graph menu to find a point of 
interest in a specified range of any graphed function. Choose a tool to 
find zero, the minimum or maximum, the point of intersection or 
inflection, or the numeric derivative (dy/dx) or Integral on the graph. 

1. Select the point of interest that you want to find on the Analyze 

Graph menu. For example, to find a zero, press b 6 1.

non-CAS CAS

Zero b 6 1 b 6 1

Minimum b 6 2 b 6 2

Maximum b 6 3 b 6 3

Intersection b 6 4 b 6 4

Inflection Not applicable b 6 5

dy/dx b 6 5 b 6 6
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The icon for the selected tool is displayed at the top left on the work 
area. Point to the icon to view a tooltip about how to use the selected 
tool. 

2. Click the graph you want to search for the point of interest, and then 
click a second time to indicate where to start the search for the point. 

The second click marks the lower bound of the search region and a 
dotted line is displayed.

Note: If you are finding the derivative (dy/dx), click the graph at the 
point (numeric value) to use for finding the derivative.

3. Press ¡ or ¢ to move the dotted line that marks the search region, and 
then click the point at which you want to stop the search (upper 
bound of the search region). 

4. Press · at the point to start the search. The tool shades the range. 

If the search region you specified includes the point of interest, a 
label for the point is displayed. If you change a graph that has points 
of interest identified, be sure to check for changes in points of 
interest. For example, if you edit the function on the entry line or 
manipulate a plot, the point where the graph intersects zero can 
change. 

The labeled points of interest remain visible on the graph. You can 
exit the tool by pressing d or choosing another tool. 

Integral b 6 6 b 6 7

Analyze Conics b 6 7 b 6 8

non-CAS CAS
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Working with Variables in the Scratchpad
Scratchpad variables are shared between Scratchpad Calculate and 
Scratchpad Graph, but not with any TI-Nspire™ documents. If you use the 
same name for a Scratchpad variable and a variable in a document, no 
conflict occurs unless you attempt to copy expressions between 
documents and the Scratchpad.

Saving the Scratchpad Contents
You can save the Scratchpad Calculate page, the Scratchpad Graph page, 
or both as a TI-Nspire™ document.

1. Press ~, and then select Save to Document (~ A).

2. Press ·.

The Save to Document dialog box opens.

3. Select the page or pages to save.

4. If a document is open, select either New or Current document.

5. Click Save.

• If you selected to save to a current (open) document, the 
Scratchpad pages are added to the document.

• If you selected to save the Scratchpad pages to a new document, 
the pages are converted to an unsaved document. To save the 
document:

– Press ~ > Save. The Save As dialog box opens.

– Type a name for the document.

– Select Save to save the new document.
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Clearing Scratchpad Contents
Complete the following steps to delete the calculations and graphing 
work from the Scratchpad application.

1. Press ~ > Clear Scratchpad (~ B).

2. Press · to delete the Scratchpad contents.
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Working with Documents on TI-Nspire™ 
Handhelds

All of the work you do with a TI-Nspire™ handheld is contained in one or 
more TI-Nspire™ documents, which you can share with other handheld 
users and with those using the computer software.

• Each document is divided into at least one, and up to 30, problems.

• Each problem contains at least one, and up to 50, pages.

• Each page can be divided into as many as four work areas. 

• Each work area can contain any of the TI-Nspire™ applications 
(Calculator, Graph, Geometry, Lists & Spreadsheet, Data & Statistics, 
Notes, and Vernier DataQuest™).

Opening a Document
1. From the Home screen, select My Documents.

—or—

Press 2. 

The file manager opens.

2. Navigate to the file you want to open. 

• Press ¤ to highlight the document name, and then press x or 

· to open the document.

• If the file is in a folder, press ¤ to highlight the folder, and then 

press x or · to open the folder.

3. Press ~ to open the Documents menu to access options for 
working with the open document.
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Creating a New Document
1. From the Home screen, select New Document.

—or—

Press 1. 

You can also press / N.

A new document opens with a list of applications. 

Note: The tab at the top left of the screen indicates that this is the 
first page of the first problem.

2. Use ¤ and £ to highlight the application you want to add to the 

page, and then press · to open the page.
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Saving Documents
To save the document in the My Documents folder:

1. Press ~ to open the Documents menu, and then select File > Save. 

Note: You can also press ~ 1 4 or / S to save a document. 

The Save As dialog box opens.

If you are saving the document for the first time, you will be asked 
which folder to save it to, and what to name the document. The 
default folder is My Documents.

2. Type a name for the document.

3. Click Save to save the document in the My Documents folder.

Saving a Document in a Different Folder
To save the document in a different folder:

1. From an open document, press ~ 1 5.

The Save As dialog box opens.

2. Press g e to navigate to the list of existing folders. The first 
folder in the list is selected.

3. Use the ¤ and £ to scroll through the list of folders. 

4. To select and open a folder, press x.

5. Type a name for the document.

6. Click Save to save the document in the selected folder.

Saving a Document in a New Folder
To save the document in a new folder:
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1. From an open document, press ~ 1 5.

The Save As dialog box opens.

2. Press e until the New Folder icon is highlighted, and then press 

· to create a new folder. 

The new folder is added to the bottom of the list of existing folders. 
By default, the folder name is “Folder1.”

3. Type a name for the new folder, and then press · to save.

4. Press · again to open the folder. 

The File Name field becomes active.

5. Type a name for the document.

6. Click Save to save the document in the new folder.

Working with Applications
Options for working with applications include:

• Creating a new document and selecting an application

• Adding a new page and application to an open document

• Adding multiple applications to a page in a document 

Adding an Application
There are multiple ways to add an application to a page:

• When creating a new document, use the Touchpad or corresponding 
numbers to select an application from the list of applications.

À New folder icon

Á Type new folder name
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• To add a new page and application to an open document, press 
/ ~, and then select an application from the list.

For example, press 2 to add the Graph application to the page. The 
application opens in the work area.

You can also press c, and then select an application from the Home 
screen by clicking one of the following application icons:

Calculator

Graphs

Geometry

Lists & Spreadsheet

Data & Statistics

Notes

Vernier DataQuest™
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Using Multiple Applications on a Page
You can add up to four applications to each page.

When you create a new document, it contains space to add one 
application. If you need to add more than one application to a page, you 
can change the layout to accommodate as many as four applications.

You can choose a standard layout, provided as a menu item, or you can 
customize a layout to suit your needs.

Choosing a Standard Page Layout

1. Press ~ 5 2 to display layout options.

2. Press the number that corresponds to the layout you want. 

For example, press 2 to create a two-pane layout, divided vertically 
on the page. 

3. Press / e to move between panes. Bold lines around the pane 
indicate that the pane is active.
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4. Press b, and then press the number of the application you want to 

add the new pane. For example, press 4 to add the Lists & 
Spreadsheet application.

 

Note: If you need to change the layout of the page to add or delete 
applications, you can do so at any time. When deleting an 
application, select the application to be deleted first. 

Creating a Custom Page Layout
If the standard layouts do not meet your needs, you can customize the 
space allotted to applications on a page. 

1. Press ~ 5 to display layout options.

2. Press 1 to select the custom split option.

The standard layout is displayed with a divider between the 

application panes. Use the arrows ( ) in the middle of the divider to 
adjust the size of the panes.
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3. Press £, ¤, ¡, or ¢ to move the divider to adjust the height or width 
of the panes in the layout.

4. Press + or - to select a defined layout:

• Pressing - returns to a full page layout.

• Pressing + once switches layout from a vertical layout to a 

horizontal layout. Press - to go back to a vertical layout.

• Pressing + twice adds a third pane to the page. Pressing + 
multiple times enables you to choose between a vertical and 
horizontal page layout with three panes.

• Pressing + five times adds a fourth pane to the page. Press - to 
cycle through the previous layout options.

5. Press x or · to accept the layout dimensions.

6. Press / e to move between panes. Bold lines around the pane 
indicate that the pane is active.

Swapping Applications on a Page
If you want to change the position of applications on a page with 
multiple applications, you can do so by “swapping“ the positions of two 
applications.

1. Press ~ 5 Page Layout 4 Swap Application.

The selected application is surrounded by a heavy, flashing black 
border, and the Swap App cursor é is displayed on the screen.

Note: On a two-pane page layout, the selected application 
automatically swaps position with the opposite pane. Press x  

or · to complete the swap.
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2. Press £, ¤, ¡, or ¢ to position the cursor over the application you are 
targeting to swap. 

3. Press x or · to complete the swap.

Note: Press d to cancel the swap.

Grouping Applications
To group up to four application pages into a single page:

1. Select the first page in the series.

2. From the Document menu, select Page Layout > Group.

Press ~ 5 7.

The next page is grouped with the first page. The page layout 
automatically adjusts to display all the pages in the group.

Ungrouping Pages
To ungroup the pages:

1. Select the grouped page.

2. From the Document menu, select Page Layout > Ungroup.

—or—

Press ~ 5 8.

The material becomes individual pages for each application.

Deleting an Application from a Page
1. Click the application you want to delete. 

2. From the Document menu, select Page Layout > Delete Application.

—or—

Press ~ 5 5.

The selected application is deleted.

If you want to undo the delete, press Ctrl-Z.

Using the Application Menu
The Application menu enables you to select tools for working with a 
specific application. Each application has a unique menu. 

Using the Application Menu

1. From a blank page, press b to display the Application menu. 
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The menu displays applications that you can add to the page.

2. Press the number of the application you want to add to the page. For 
example, press 4 to add the Lists & Spreadsheet application.

3. Press b to display the Application menu, which lists the options for 
working with the current application.

The example below displays the Application menu for the Lists & 
Spreadsheet application.

Context Menus
Context menus display options that are specific to the selected object or 
the current cursor location. 

Using the Context Menu
 To access a context-sensitive menu from an application, press 

/ b.

In the example below, the context menu displays options available for 
the selected cell in Lists & Spreadsheet.
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Working with Problems and Pages
The options on the Documents menu let you:

• Save a document

• Access edit functions such as undo, redo, cut, copy, paste, and delete

• Move between pages and open the page sorter view for documents 
with multiple pages

• Modify page layout, insert pages or problems, delete pages, and 
change settings

• Add problems, pages, and applications to open documents

• Access page layout options

Adding a Problem to a Document
Adding problems to a document enables you to reuse variable names. A 
document can contain as many as 30 problems. To add a new problem:

1. Press ~ 4 1 to open the Insert options.
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A new problem with one page is added to the document. The tab at 
the top left of the screen indicates that this is the first page of the 
second problem. 

2. Press b to open the Application menu, and then press the number 
corresponding to the application you want to add to the new page. 

Viewing and Reordering Pages in a Document
The Page Sorter displays all of the problems in your document and all 
pages within each problem in thumbnail format. You can use the Page 
Sorter to rearrange and delete pages, copy a page from one problem and 
paste it into another, and apply templates to pages.

Viewing Multiple Pages with the Page Sorter
Although the handheld typically displays the pages in your document 
one at a time, the Page Sorter lets you see all of the problems in your 
document and all pages within each problem in thumbnail format. You 
can use the Page Sorter to rearrange and delete pages, and copy a page 
from one problem and paste it in another.

Opening the Page Sorter from a Document

 Press / £.

The Page Sorter screen displays all of the problems and pages in the 
current document.
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Reordering Pages in a Problem

Use the Page Sorter (press / £) to move a page within a problem with 
multiple pages:

1. Press the ¡ or ¢ key to select the page you want to move.

A heavy border around the page indicates that it is selected.

 

2. Either press and hold x or press / x until the grab cursor ÷ is 
displayed. 

3. Press ¡ , ¢,  £ or ¤ to move the page to the desired position.

4. Press x or · to finish the move.

Note: You can press d to cancel.

The page moves to the new location within the problem, and the 
counter adjusts accordingly.

Copying a Page to Another Problem
To copy a page from one problem to another in the same document:
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1. Press / £ to open Page Sorter.

2. Press ¡ , ¢,  £ or ¤ to select the page you want to copy.

A heavy border around the page indicates that it is selected.

3. Press / C to copy the page.

4. Press ¡ , ¢,  £ or ¤ to select the desired position in the problem 
where you will paste the page. The copied page will be placed after 
the page you select.

5. Press / V to paste the page in the new location.

The page is copied to the new location within the problem, and the 
counter adjusts accordingly.

Note: If the page contains variables with the same names as the new 
problem, a conflict may occur. Rename the variables if necessary.

Copying a Page to Another Document
To copy a page from one document to another document:

1. Press / £ to open the Page Sorter.

2. Press ¡ , ¢,  £ or ¤ to select the page you want to copy.

A heavy border around the page indicates that it is selected.

3. Press / C to copy the page.

4. Press c 2 to open My Documents.

5. Press £ and ¤ to highlight the folder containing the document you 
want to copy the page to. 

6. Press ¢ to open the folder.

—or—
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Press b 3.

7. Press the £ and ¤ keys to highlight the document. 

8. Press x or · to open the document.

9. Press / £ to display the Page Sorter.

10. Press ¡ , ¢,  £ or ¤ to move the page to the desired position in the 
document. 

11. Press / V to paste the page in the new location.

The page moves to the new location within the problem, and the 
counter adjusts accordingly.

Copying, Pasting, and Deleting Problems
You can copy and paste a single problem from one location to another 
within the same document or a different document. You can also delete 
a problem from the document.

Copying and Pasting a Problem
To copy and paste a problem:

1. Open the Page Sorter.

Press /  £.

—or—

Press ~ 3 3.

2. Select the problem. If there are multiple problems, you can press 
b 2 to collapse the Page Sorter to list the problems by number 
and title only.
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3. Press / C.

4. Go to the location where you want the problem to appear.

5. Press / V.

A duplicate problem is placed in the new location.

Deleting a Problem
To delete a problem from the document:

1. Select the problem from the Page Sorter.

2. Press / X.

The problem is deleted from the document.

Renaming a Problem
To rename a problem:

1. With the document active, open the Page Sorter.

Press /  £.

2. Select the problem name.

3. Press / b.

4. Select 7 Rename and type the name.

5. Press / S to save the change.

Adding a Page to a Problem
Each problem can contain up to 50 pages. To add a new page to a 
problem:

 Press / ~ or / I to add a blank page and select an 
application.

—or— 

 Press c to display the Home screen, and then point to the 
application you would like to add to the new page and click or tap.

A new page is added to the current problem. 
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Note: The tab at the top left of the screen indicates that this is the 
second page of the second problem. 

Moving Through Pages in a Document
Tabs display up to three multiple pages. When a document contains more 
than three pages, arrows appear on the left and right of the tabs. 

Use the following keys to navigate through your documents.

• /  ¡  displays the previous page.

• /  ¢  displays the next page.

• /  £  displays the Page Sorter.

• /  ¤ displays the previous view.

• Use the Touchpad to click on the arrows that appear on either side of 
the tabs to show additional pages in a document containing more 
than three pages.

Managing Documents
My Documents is a file manager in which you store and organize your 
documents. The example below illustrates the My Documents screen with 
its main parts labeled. Following the screen, you can find descriptions of 
each labeled part.
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Browsing Files in My Documents
To open My Documents:

 Press c 2.

Note: If you are working in a page, press / £ / £.

The My Documents screen opens, displaying all folders and files on 
the handheld.

À Expanded folder

Á Current, unsaved document

Â Collapsed folder

Ã System status indicators

Ä File size



Working with Documents on TI-Nspire™ Handhelds 45

• To sort columns by name or size, click that column head. Click 
again to change the sort from ascending to descending.

• To scroll through My Documents, click or grab the scroll bar.

• To expand a single folder, point to the folder and click on the 
folder icon or press / ¢. To collapse, click again or press / ¡.

• To expand all folders, press b 7. To collapse, press b 8.

Renaming Folders or Documents
To rename a folder or document:

1. Press the £ and ¤ keys to highlight the document or folder you want 
to rename. 

2. Press b 2. 

 

The document or folder name is highlighted. 

3. Type a new name and press · to complete the change.

Note: Press d to cancel.
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Creating Folders 
You can create folders two different ways:

• You can create a folder when you save a new document: The Save 
and Save As menu commands allow you to enter a new folder name 
for the document. 

• You can create a folder directly from the My Documents screen. Press 
b 1. Type a name for new folder, and press x or · to add it.

File and Folder Naming Conventions
Folder names must be unique. File and folder names can be very long, 
and can include almost all characters, including spaces and punctuation.

Note: If you are planning to transfer these documents to your computer 
for use in the TI-Nspire™ software, it is best to use names that are 
accepted on your computer. Avoid punctuation, \, /, or symbols.

Deleting Documents and Folders

1. Press £ and ¤ to highlight the document or folder you want to 
delete.

2. Press / b 6.

—or—

Press .. 

A dialog box opens, confirming that you want to delete the file or 
folder.
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3. Press x or · to select Yes.

The document is deleted.

Duplicating Documents and Folders

Use Copy / C and Paste / V to duplicate documents and folders.

To copy a document to another folder, select the desired folder, and then 
paste.

Recovering Deleted Documents
Most operations performed in My Documents can be undone. Press 
/ Z (Undo) to cancel the last operation until the deleted document is 
restored.

Closing a Document

1. To close a document, press ~ 1 3.

—or—

Press / W.

If you have changed the document, you will be asked whether you 
want to save those changes.

2. Click Yes to save the document or click No to abandon the changes.

Understanding the TI-Nspire™ Tools
This section provides an overview of the tools used when working with 
TI-Nspire™ documents on a handheld, including variables, catalog, 
symbols, and math templates. 
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Creating TI-Nspire™ Variables 
Variables can be any portion or attribute of an object or function created 
within an application. Examples of attributes that can become variables 
are the area of a rectangle, the radius of a circle, the value contained in a 
spreadsheet cell or the contents of a column, or a function expression. 
When you create a variable, it is stored in memory within the problem. 
You will find more information about variables in the chapter titled 
Using Variables.

Using the Catalog
Use the catalog to access a list of TI-Nspire™ commands and functions, 
units, symbols and expression templates. Commands and functions are 
listed alphabetically. Commands or functions not beginning with a letter 
are found at the end of the list (&, /, +, -, and so on). To open the catalog:

1. From an open document, press k to open the catalog.

2. Press the number key corresponding to the appropriate tab. 

For example, press 2 to show a list of math functions.

3. Press 6 until the item you want to insert is highlighted.

A syntax example for the selected item is displayed at the bottom of 
the screen.

Note: To see additional syntax examples of the selected item, press 
e, and then press · to maximize or minimize the Help. To move 

back to the selected item, press g e.

4. Press · to insert the item.
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About the Catalog Window
The catalog window uses these tabs to categorize commands, special 
characters, and templates in documents:

CAS:

Using Wizards
Some catalog functions have a wizard to help you enter function 
arguments. To use a wizard, press e until the Wizards On box is 

highlighted. Press x or · to select the check box.

Contains all commands and functions, in alphabetical 
order

Contains all math functions

Provides a symbol palette for adding special characters

Contains math templates for creating two dimensional 
objects, including product, sum, square root, and integral

Shows public library (LibPub) objects

Contains all commands and functions, in alphabetical 
order

Contains all math functions

Provides the values for standard measurement units

Provides a symbol palette for adding special characters

Contains math templates for creating two dimensional 
objects, including product, sum, square root, and integral

Shows public library (LibPub) objects
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Entering Special Characters
The symbol palette contains a subset of the objects found in the catalog. 
To open the symbol palette:

1. In an open document, press / k.

2. Press ¡, ¢, £, or ¤ to select a symbol.

3. Press · to insert the symbol.

Entering Math Expressions
Use math expression templates to create two-dimensional objects such as 
summation, integral, derivative, and square root. To open the math 
expressions palette:

1. In an open document, press t.
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2. Press ¡, ¢, £, or ¤ to select an expression.

3. Press x or · to insert the expression.

Entering International Language Characters

Use the ; key to enter specially accented or punctuated characters in 
applications such as Notes that allow text input. 

1. Open an application such as Notes that allows text input. 

2. Type the desired text.

3. Position the cursor after the letter that you want to accent. For 
example, “e” while in the French locale. 

4. Press ; on the keypad. Notice that the “e" changes to “é.“ Keep 

pressing ; until you find the accented version of e that you want. 

Press _ or the next letter of your text to accept the character and 

continue typing. 
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Working with Images

Images can be used in TI-Nspire™ applications for reference, assessment, 
and instructional purposes. You can add images to the following 
TI-Nspire™ applications:

• Graphs & Geometry

• Data & Statistics

• Notes

• Question, including Quick Poll

In the Graphs & Geometry and Data & Statistics applications, images are 
set in the background behind the axis and other objects. In the Notes and 
Question applications, the image is set at the cursor location inline with 
the text (in the foreground).

You can insert the following image file types: .jpg, .png, or .bmp. 

Note: The transparency feature of a .png file type is not supported. 
Transparent backgrounds are displayed as white.

Working with Images on a Handheld
On a handheld, images can be copied from one document to another or 
resized or repositioned within a document. You can also delete images 
from a document. 

You cannot add or insert images into a document when working on a 
handheld. However, you can transfer a document containing an image 
from your computer to a handheld. If using a TI-Nspire™ CX handheld, 
colors are retained. If transferred to a TI-Nspire™ handheld, the colors in 
the image are converted to gray scale. 

Note: If there is not enough memory on the handheld to accommodate a 
document containing an image, an error message is displayed.

Copying an Image
Complete the following steps to copy an image from one document to 
another or from one page to another within the same document.

1. Open the document that contains the image you want to copy.

2. Select the image.

• In the Question or Notes applications, move the cursor over the 
image and press x. 

• In the Graphs & Geometry application, press b 1 2 2.
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• In the Data & Statistics application, press b 3 6.

A border appears around the image.

3. Press / b, and then click Copy. You can also press / C.

4. Open the document where you want to paste the image or select a 
page in the current document. 

Note: If you open a new document, you will be prompted to save and 
close the current document.

5. Press / V.

Note: If pasting an image into the Graphs & Geometry application, 
press ·, and then press / V.

The image is copied to the page in the document.

Repositioning an Image
Complete the following steps to reposition an image on a page.

1. Open the document and navigate to the page that contains the 
image.

2. Select the image.

• In the Question or Notes applications, move the cursor over the 
image, and then press, hold, and release x. The image appears 
shaded.

• In the Graphs & Geometry application, press b 1 2 2.

• In the Data & Statistics application, press b 3 6.

A border appears around the image.

3. Move the image.

• In the Question or Notes applications, move the cursor to the new 
location and press x.

• In the Graphs & Geometry or Data & Statistics applications:

– Press and hold x until the cursor changes to a four-sided 

arrow ( ). The image floats in the background and the 
border changes to a dashed line.

– Move your finger over the Touchpad to move the image to the 
new location, and then press x or · to place the image.
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Resizing an Image
Complete the following steps to resize an image on a page.

1. Open the document that contains the image.

2. Select the image.

• In the Question or Notes applications, or in Quick Poll, move the 
cursor over the image and press, hold, and then release x. The 
image appears shaded.

• In the Graphs & Geometry application, press b 1 2 2.

• In the Data & Statistics application, press b 3 6.

A border appears around the image.

3. Move the cursor to one of the corners.

The cursor changes to a four-sided directional arrow ( ).

Note: If you move the cursor to the edge of an image, the cursor 
changes to a two-sided directional arrow. You can drag the image left 
or right to resize it, but the image will become distorted.

4. Press x.

The  tool is enabled.

5. Move your finger over the Touchpad in any direction to resize the 
image. 

A dashed line appears to indicate the new size.

6. To accept the new size, press x or ·.

Deleting an Image
Complete the following steps to remove an image from a page.

1. Open the document that contains the image.

2. Select the image.

• In the Question or Notes applications, move the cursor over the 
image, and then press, hold, and release x. The image appears 
shaded.

• In the Graphs & Geometry application, press b 1 2 2.

• In the Data & Statistics application, press b 3 6.

A border appears around the image.
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3. Press / b, and then select Delete.

The image is removed.

Note: In the Question and Notes applications, you can also press . 
to remove a selected image.
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Working in a TI-Nspire™ Navigator™ 
Teacher Software Classroom

If you are in a classroom where TI-Nspire™ Navigator™ Teacher Software 
is used, you will need to log in to class to communicate with the teacher’s 
computer. The teacher can communicate with your handheld in the 
following ways:

• Send files

• Collect files

• Delete files

• Send Quick Polls and receive Quick Poll responses

The teacher can also pause and restart your handheld. When class is 
paused, you will receive a message on your handheld. You cannot use 
your handheld until the teacher releases the handheld from pause mode.

Pausing a Class Session
There are times when a teacher may want to pause a class. Pausing a class 
suspends all activity on your handheld. When the teacher resumes class, 
the message clears and you are able to use the handheld.

Logging In to Class
To log into class from a handheld with the 3.1 operating system, 
complete the following steps to connect to a classroom session.

1. From the Home screen, press 5 5. From an open document, press 

~ 8.

The Login to Class dialog box opens.
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2. Type your user name and password.

3. Click Login.

The Login Successful screen opens.

4. Click OK.

Connecting to the TI-Nspire™ Navigator™ System
To connect to the TI-Nspire™ Navigator™ network, you must log in to 
the network from your handheld. Before you can log in, the teacher 
must complete the following tasks:

• Start a class session on their computer.

• Provide you with the class network name, a username and, if 
necessary, a password.

Note: Use this method to log in to the network if the operating system 
on the handheld is version 3.2 or higher.

Logging in to the TI-Nspire™ Navigator™ Network

1. Ensure your TI-Nspire™ handheld is ready for login. (The icon is 
blinking.)

2. Attach a wireless adapter or wireless cradle to the handheld.

3. Complete one of the following actions:

• From the Home screen, press 5 5. 

• From an open document, press ~ 8.

The Login to Class dialog box opens and the last network that was 
associated with the wireless client appears.

Note: If the handheld is connected to the computer with the USB 
cable, no network names appear on the screen, and you can continue 
logging in. 
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4. If the name of the network that appears is correct, click Login. If the 
network is not correct, click Network. 

The handheld screens displays the last network the wireless client was 
attached to, and also displays other networks within range.

5. Select the network from the list, and then click Connect.

The login screen shows the connection status and displays the 
network name when the connection is successful.

6. Type your username and password.

7. Select Login.

The Login Successful screen opens.

8. Click OK.

TI-Nspire™ Handheld Login Status Icons
The icons on the TI-Nspire™ CX, TI-Nspire™ CX CAS, TI-Nspire™, and 
TI-Nspire™ CAS handheld screens indicate the communication status 
between the handheld and the access point, wireless adapter, wireless 
cradle, or TI-Navigator™ network. The icons indicate status as follows.

Icon Status Meaning

Blinking The handheld is searching for an access 
point.

Solid The handheld has found an access point.
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Understanding File Transfers
During a class session, the teacher can send files to student handhelds 
and collect or delete files from student handhelds. 

Note: Before class starts, teachers can set up actions to send or collect 
files. When you log in, the files are sent or collected.  If the teacher set up 
actions to both send and collect files, you will only see the dialog box for 
the last action completed.

Opening Sent Files
When the teacher sends a file to your handheld, the Transfers Complete 
dialog box opens.

 Click Open to open the file. If the teacher sent multiple files, this 
opens the last file in the list.

Note: The files are received alphabetically by name, no matter which 
order the teacher sent them in. The last file in the list is the last 
alphabetical file.

 Click Go To to go to the location on the handheld where the file was 
sent. The file name is highlighted. You can open that file, or navigate 
to another file. If the teacher sent multiple files, the last alphabetical 
file in the list is highlighted.

Solid The handheld is not communicating 
with the adapter or cradle. Remove the 
handheld from the adapter or cradle, 
wait for the icon to disappear, and then 
reattach the handheld to the adapter or 
cradle.

Blinking The handheld is connected to the 
network and is ready to login.

Solid The handheld is logged in to the 
network.

Icon Status Meaning
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 Click Cancel to dismiss the dialog box without opening the file. Your 
handheld returns to the state it was in when the message was sent.

Collecting or Deleting Files
Your teacher may collect or delete files from your handheld during a class 
session. For example, teachers can collect homework assignments or 
delete certain files prior to a test. When the teacher collects or deletes 
files, you receive a message on your handheld.

 Click Cancel to dismiss the message.
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Configuring Handhelds

This chapter provides information needed to:

• Maintain batteries used in the handheld. 

• Change the default settings.

• Attach a wireless module when the handheld is used in the classroom.

Checking Battery Status
To check the status of the TI-Nspire™ Rechargeable Battery in a 
handheld:

1. Press c.

The Home screen opens.

2. Press 5 4 (Settings > Status). 

The Handheld Status dialog box opens.

3. Click OK or press · to close the window.

Note: From an open document, press ~ 7 4 (~ > Settings & 
Status > Status).

Recharging the Handheld
To recharge the TI-Nspire™ Rechargeable Battery in a handheld, connect 
it to any of the following power sources:

• A standard USB cable connected to a computer

• A TI USB wall charger (sold separately)

Battery status is 
shown here.
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• A TI-Nspire™ CX Docking Station if in a classroom setting

The amount of time required to fully charge the battery may vary, but 
charging normally takes about six hours. It is not necessary to remove the 
TI-Nspire™ Rechargeable Battery from the handheld to recharge it. The 
handheld operates normally while it is attached to a charging source.

Recharging a Battery from a Computer
To recharge a handheld from a computer, a TI-Nspire™ USB driver must 
be installed. USB drivers are standard with any TI-Nspire™ software, 
which includes:

• TI-Nspire™ Teacher Software

• TI-Nspire™ CAS Teacher Software

• TI-Nspire™ Student Software

• TI-Nspire™ CAS Student Software

• TI-Nspire™ Navigator™ Teacher Software

• TI-Nspire™ CAS Navigator™ Teacher Software

To download software that includes a driver, go to 
education.ti.com/software.

Understanding the Priority of Power Sources
When the TI-Nspire™ Rechargeable Battery is fully charged, the 
handheld draws power in the following order:

• First, from a connected external power source, such as:

– A computer connected through a standard USB cable

– An approved wall charger (sold separately)

• Second, from the TI-Nspire™ Rechargeable Battery 

Disposing of Used Batteries Safely and Properly
Do not mutilate, puncture or dispose of batteries in fire. The batteries 
can burst or explode, releasing hazardous chemicals. Discard used 
batteries according to local regulations.

Changing Handheld Settings
Use the options on the Settings menu to change or view the following 
settings:

• Change language

• Settings (Document and Graphs & Geometry)
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– Define or restore settings for open documents and the Scratchpad

– Define or restore default settings for the handheld

• Handheld Setup

• Status

• Login

Note: Not all options are accessible at all times. Options that are 
unavailable are disabled.

Opening the Settings Menu

 From the Home screen, press 5 or use the Touchpad to select 
Settings.

The Settings menu opens.

Changing a Preferred Language
Complete the following steps to change a preferred language:

1. From the Home screen, press 5 or select Settings to open the menu.

2. From the menu, select Change Language or press 1. 

The Change Language dialog box opens.
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3. Press ¢ to open the drop-down list.

4. Press ¤ to highlight a language, then press x or · to select it.

5. Press e to highlight the OK button, then press x or · to save 
the language selection.

Customizing the Handheld Setup
Handheld setup options enable you to customize options to suit your 
needs. 

• Font size (small, medium or large).

• Power standby. (1, 3, 5, 10 or 30 minutes).

– Use this option to extend battery life.

– By default, the handheld automatically powers down after three 
minutes of inactivity.

• Hibernate (1, 2, 3, 4, 5 days or never).

– Use this option to extend battery life.

– By default, the handheld hibernates after four days.

– When hibernating, the handheld saves current work in memory.

– When you turn the handheld on again, the system reboots and 
opens saved work.

• Pointer speed (slow, normal or fast).

• Auto dim (30, 60 or 90 seconds, and two or five minutes).

• Enable tapping to click.

Changing Handheld Setup Options

1. From the Home screen, press 5 3 (Settings > Handheld Setup). 
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The Handheld Setup dialog box opens.

 

2. Press e until the desired category is highlighted.

3. Press ¢ to view the list of possible settings.

4. Press 6 to highlight the desired setting.

5. Press x or · to select the new setting.

6. When you have changed all the settings to suit your needs, press 
e until OK is highlighted, then press x or · to apply your 
changes. 

Note: Click Restore to return the handheld to the factory settings.

Customizing Document Settings
Document settings control how the handheld displays and interprets 
information in TI-Nspire™ documents and in Scratchpad. All numbers, 
including elements of matrices and lists, are displayed according to the 
document settings. You can change the default settings at anytime and 
you can also specify settings for a particular document. 

Document settings and their possible values are listed in the following 
table.

Field Values

Display Digits Float
Float1 - Float12
Fix0 - Fix12

Angle Radian
Degree
Gradian
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Changing Default Document Settings
Complete the following steps to define default document settings for 
TI-Nspire™ documents and Scratchpad. 

1. Save and close any open documents.

2. From the Home screen, press 5 2 (Settings > Document Settings). 

The Document Settings dialog box opens.

Note: If a document is open, the Document Settings dialog box also 
contains an OK button. If you select OK, settings are only applied to 
the open document.

Exponential Format Normal
Scientific
Engineering

Real or Complex Real 
Rectangular
Polar

Calculation Mode Auto
CAS: Exact
Approximate

Note: Auto mode displays an 
answer that is not a whole number 
as a fraction except when a decimal 
is used in the problem. Exact mode 
(CAS) displays an answer that is not 
a whole number as a fraction or in 
symbolic form, except when a 
decimal is used in the problem.

Vector Format Rectangular
Cylindrical
Spherical

Base Decimal
Hex
Binary

Unit System (CAS) SI
Eng/US

Field Values
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3. Press e to move through the list of settings. Press £ to move 
backward through the list.

A bold line around a box indicates it is active.

4. Press ¢ to open the drop-down list to view the values for each setting.

5. Press the £ and ¤ keys to highlight the desired option, then press 

x or · to select the value.

6. Select Make Default.

The Apply and Save as Default dialog box opens.

7. Click OK to save the settings as default settings that will be applied to 
all TI-Nspire™ documents and to Scratchpad.

Changing Document Settings in a TI-Nspire™ Document
Complete the following steps to change document settings for an open 
TI-Nspire™ document. You can apply the settings to the current 
document only or choose to make the settings the default settings for 
the open document and all future documents.
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1. From an open document, press c 5 2 (c > Settings > 
Document Settings).

The Document Settings dialog box opens.

2. Press e to move through the list of settings. Press £ to move 
backward through the list. 

A bold line around a box indicates it is active.

3. When you reach the desired setting, press ¢ to open the drop-down 
list to view values for each setting.

4. Press the 5 and 6 keys to highlight the desired option, then press 

x or · to select the value.

5. Click OK or press x or · to apply the new settings only to the 
open document.

The Home screen opens and the new settings are only applied to the 
open document. 

To apply the new settings to the open document and to documents 
created in the future:

• Select Make Default and press x or ·.

• Click OK to apply the settings to any open documents and save the 
settings as defaults for new documents and for Scratchpad.

Restoring Document Settings
Complete the following steps to restore the original factory settings to 
open or new documents, and to the Scratchpad.

1. From the Home screen, press 5 2 (Settings > Document Settings). 

The Document Settings dialog box opens.
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2. Use the Touchpad or press e to select Restore, then press ·. 

The Restore Defaults dialog box opens.

3. Click OK to restore settings to the factory default settings.

4. Press OK or d to return to the Home screen.

Customising Graphs & Geometry Settings
Graphs & Geometry settings control how information is displayed in 
open problems and in subsequent new problems. When you customize 
application settings, your selections become the default settings for all of 
your work in the Graphs & Geometry application. 

Complete the following steps to change the Graphs & Geometry Settings 
and make these settings the default for all new graphs and geometry 
documents and Scratchpad.

1. Open a document with the Graphs or Geometry application active.

2. Press b 9 (b > Settings). 

The Graphs & Geometry Settings dialog box opens.
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3. Press e to move through the list of settings. Click ¢ to open the 
drop-down list to view the values for each setting.

4. Press ¤ to view the values, then press x or · to select a value.

5. In the lower half of the dialog, select a checkbox to enable an option 
or clear a checkbox to disable an option.

6. Choose one of the following options:

• To apply the customized settings to ALL graphs and geometry 
documents, click Make Default. When the Apply and Save as 
Default dialog box opens, click OK.

Field Values

Display Digits Auto

Float

Float1 - Float12

Fix0 - Fix12

Graphing Angle Auto

Radian

Degree

Gradian

Geometry Angle Auto

Radian

Degree

Gradian

Checkbox Operation when selected

Automatically hide 
plot labels

Plot labels display only when a plot is 
hovered, selected or grabbed.

Show axis end values Displays a numeric label at the least 
and greatest values visible on an axis.

Show tool tips for 
function manipulation

Shows helpful information as you 
manipulate function graphs.

Automatically find a 
point of interest

Shows zeros, minima and maxima for 
graphed functions and objects while 
tracing function graphs.
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• To apply the settings to the open document only, click OK.

• To restore default settings, click Restore. When the Restore 
Defaults dialog box opens, click OK.

• Click Cancel to close the dialog box without making changes.

Viewing Handheld Status
The Handheld Status screen provides the following information about 
the current state of the handheld:

• Battery status for the rechargeable batteries

• Software version

• Available space

• Network (if any)

• Your student login name and whether you are logged in 

• About

Opening the Handheld Status Screen

1. From the Home screen, press 5 4 (Settings > Status). 

The Handheld Status screen opens.

2. Click OK to close the Handheld Status screen.

Viewing Handheld Details
The About screen provides additional information about the handheld 
type, the operating system (OS) version and the product ID.

1. From the Home screen, press 5 4 (Settings > Status). 

The Handheld Status screen opens.

2. Click About to view details about the handheld.
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3. Click OK to close the About dialog box.

4. Click OK to return to the Home screen.

Replacing TI-Nspire™ Rechargeable Batteries
When you replace the battery, complete the following steps to insert the 
TI-Nspire™ Rechargeable Battery into a handheld.

1. Use a small screwdriver to release the panel from the back of the 
handheld.

2. Remove the panel.

3. Remove the old battery.
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4. Insert the white connector of the new battery into the jack located at 
the top of the battery compartment.

5. Thread the wire into the case to secure it. Insert the rechargeable 
battery into its compartment.

6. Replace the back panel and fasten the screws with a screwdriver.

Using Wireless Communication Hardware
Teachers using TI-Nspire™ Navigator™ Teacher Software in the classroom 
can use TI-Nspire™ Navigator™ Cradles or TI-Nspire™ CX Wireless 
Network Adapters along with the TI-Nspire™ Navigator™ Access Point to 
establish wireless communication between TI-Nspire™ CX handhelds and 
their computer. The network adapters can only be used with the 
TI-Nspire™ CX handhelds.

Use the wireless cradle to establish a wireless connection between the 
teacher computer and any TI-Nspire™ handheld. 
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Attaching a Wireless Adapter to a CX Handheld
The TI-Nspire™ CX Wireless Network Adapters work with the TI-Nspire™ 
CAS and TI-Nspire™ CX CAS handhelds. The battery in the TI-Nspire™ CX 
handheld powers the wireless adapter. To connect the handheld to the 
wireless adapter:

1. Position the wireless adapter on top of the handheld so the connector 
on the adapter lines up with the connector on top of the handheld. 

2. Slide the adapter into position, making sure the guides on the sides 
of the adapter slide into the grooves on the sides of the handheld.

3. Firmly press the adapter into place so that the adapter sits on top of 
the handheld as shown in the following illustration.

Wireless network adapter (school-owned)

Connector

Guides for 
aligning with 
handheld

Sideview of handheld

Groove to align 
wireless adapter
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Note: The TI-Nspire™ CX handheld can be charged with the wireless 
adapter attached.

Attaching a Wireless Cradle to a Handheld
The TI-Nspire™ Navigator™ Cradles can be used with all TI-Nspire™ 
handhelds to wirelessly connect to the teacher computer. To connect a 
handheld to a cradle:

1. Slide the lock on the back of the cradle to the OFF position.

Lock in OFF 
position.
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2. To attach the handheld, face the screen upward and slide the 
handheld onto the top of the TI-Nspire™ Navigator™ wireless cradle. 
Be sure that both sides of the handheld are inserted into both of the 
side guides.

3. Press firmly to make a good connection. When properly connected, 
the TI-Nspire™ handheld appears to be sitting on top of the cradle.

4. Lock the handheld in place by sliding the lock on the back of the 
cradle to the ON position.

Lock in ON 
position.
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Connecting Handhelds and Transferring 
Files

This chapter describes how to connect one TI-Nspire™ handheld to 
another, how to connect handhelds to a computer, and how to transfer 
files between them. 

The TI-Nspire™ handhelds have a USB port that enables connectivity with 
another TI-Nspire™ handheld or with a computer.

Note: When using the TI-Nspire™ TI-84 Plus keypad, you can connect 
with another TI-Nspire™ handheld using the TI-Nspire™ TI-84 Plus 
keypad or a TI-84 Plus using the USB port or the I/O port.

Connecting Handhelds

Using USB Cables
You can use USB cables to connect two TI-Nspire™ handhelds, to connect 
a TI-Nspire™ handheld to a computer, or to connect one TI-Nspire™ 
handheld using TI-Nspire™ TI-84 Plus keypad to another.

Connecting Two TI-Nspire™ Handhelds with the Mini-USB 
Cable 
You can connect two handhelds as long as both handhelds are using the 
same keypad. You cannot connect a handheld using the TI-Nspire™ TI-84 
Plus keypad to a handheld using the native TI-Nspire™ keypad.

TI-Nspire™ USB connection cable to 
connect handheld to a computer.

TI-Nspire™ handheld mini-USB cable to 
connect two TI-Nspire™ handhelds.
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To connect the handhelds:

1. Firmly insert either end of the mini-USB cable into the USB port.

2. Insert the other end of the cable into the receiving handhelds’s USB 
port.

The TI-Nspire™ handheld USB 
port is located in the center on 
the top of the TI-Nspire™ 
handheld.

The USB port is located on the 
top of the TI-Nspire™ CX 
handheld on the right side when 
holding the handheld with the 
screen facing you.

À Port for connecting a wireless adapter.

Á USB port on the CX handheld.
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Connecting the TI-Nspire™ Handheld to a Computer  

Transferring Files to and from Handhelds
You can send documents, Operating System (OS) files, and folders to 
another TI-Nspire™ handheld.

Rules for Transferring Files and Folders
• You can transfer documents and OS files.

• Operating systems are not interchangeable between different 
handheld types. For example, you cannot transfer a CAS operating 
system to a non-CAS handheld.

• If a document with the same name as the one you are sending 
already exists on the receiving handheld, the document will be 
renamed. The system appends a number to the name to make it 
unique. For example, if Mydata existed on the receiving handheld, it 
would be renamed Mydata(2).

Both the sending and receiving handhelds will display a message that 
shows the new name. 

• There is a 255-character maximum length for a file name, including 
the entire path. If a transmitted file has the same name as an existing 
file on the receiving handheld and the file names contain 255 
characters, the name of the transmitted file will be truncated to 
enable the software to follow the renaming scheme described in the 
previous paragraph.

• All variables associated with the document being transmitted are 
transferred with the document.

• Transmissions will time out after 30 seconds.

Caution: Some older TI-Nspire™ handhelds cannot receive folders; only 
files. If you receive an error in sending to an older TI-Nspire™ handheld, 
see Common error and notification messages.

1. Firmly insert the mini-USB end of the cable into the port at the top 
of your handheld. 

2. Firmly insert the USB end of the cable into the USB port of the 
computer.
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Sending a Document or Folder to Another Handheld
1. Ensure the two handhelds are connected.

2. Open the My Documents file browser and navigate to the file or 
folder you want to transfer.

3. Press the 5 and 6 keys on the Touchpad to highlight the document or 
folder you want to send.

4. Press ~ 1 6 to select Send from the Documents menu.

TI-Nspire™ handheld: Press ~16.

5. The file transfer begins. A progress bar shows the status of the 
transfer. There is also a cancel button in the Sending... dialog box to 
enable you to cancel the transmission while it is in progress.

At the end of a successful transmission, the message 
“<Folder / File name> transferred as <Folder / File name>.” is 
displayed. If the file had to be renamed on the receiving handheld, 
the message will show the new file name.

Receiving a Document or Folder
No action is required by the user of the receiving TI-Nspire™ handheld. 
Handhelds are automatically powered on when the cable is attached. 

At the end of a successful transmission, the message “<Folder / File 
name> received.” is displayed. If the file had to be renamed, the message 
will show the new file name.

Caution: Some older TI-Nspire™ handhelds cannot receive folders; only 
files. If you receive an error in sending to an older TI-Nspire™ handheld, 
see Common error and notification messages.

Canceling a Transfer
1. To cancel a transmission in progress, press Cancel on the sending 

handheld. The user of either handheld can also press d. 

TI-Nspire™ handheld: press d.

2. Press d or · to cancel the transmission error message. 

TI-Nspire™ handheld: press d or ·.

Transferring Files Between Computers and 
Handhelds
In the Documents Workspace, teachers and students can use the “drag 
and drop” method to quickly transfer files and folders from a computer 
to a handheld or transfer files from a handheld to a computer.
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1. Connect the handheld to the computer using a standard A to mini-B 
USB cable.

2. In the TI-Nspire™ software, open the Documents Workspace.

3. In the Documents Toolbox, click  to open the Content Explorer.

4. Navigate to the folder that contains the file you want to transfer.

• To transfer a file from a handheld to the computer, click the file, 
and then drag the file to a folder in the Computer panel.

• To transfer a file from the computer to a handheld, click the file, 
and then drag the file to a connected handheld. 

Note: Those using the TI-Nspire™ Teacher Software or the TI-Nspire™ 
Navigator™ Teacher Software can also use options in the Content 
Workspace to transfer files from a handheld to a computer.

Computer panel

Connected 
Handhelds
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Using the Save to Handheld Option
In the Documents Workspace, you can also use the Save to Handheld 
option on the File menu to transfer a file to a connected handheld when 
you want to save a file to a specific folder on the handheld.

1. Ensure the handheld is connected to the computer.

2. In the Computer panel, navigate to the folder where the file is 
located.

3. Click the file.

4. Click File > Save to Handheld. The Save to Handheld dialog box 
opens.

5. Double-click the handheld name, and then navigate to the folder 
where you want to save the file.

6. Click Save. The file is saved to the selected folder and the Save to 
Handheld dialog box closes.

Handling Errors Resulting from Sending Folders
If you receive an error after attempting to send a file, it may mean the 
receiving handheld has an operating system that does not support the 
transfer. To resolve this, update the receiving handheld’s OS and try the 
send again.
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Common Error and Notification Messages

Shown on Message and Description

Sending handheld “This folder structure is not supported on 
the receiving handheld. The receiving 

handheld’s OS may need to be updated, which 
you can do by selecting Send OS from the My 

Documents menu.”

OK

If you get an error when sending a folder to an 
older TI-Nspire™ handheld, try updating the OS on 
the receiving handheld. If the error persists, you 
may have to send the files individually.

Sending handheld “Transfer failed. Check cable and try 
again.“

OK

This message is displayed if a cable is not attached 
to the sending handheld’s link port. Remove and 
then reinsert the cable and try the document 
transmission again.

Click OK to cancel the transmission message. 

Note: The sending handheld may not always 
display this message. Instead, it may remain BUSY 
until you cancel the transmission.

Sending handheld “Receiver does not have enough storage space 
for file transfer.“

OK

This message indicates that the receiving handheld 
does not have enough memory to accept the file 
being transmitted. 

The user of the receiving handheld must free space 
to obtain the new file. To do this:

• Delete unneeded files.

• Store files on a computer for later retrieval, 
and then delete them from the TI-Nspire™ 
handheld.
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Sending handheld “<folder>/<filename> transferred as 
<folder>/<filename(#).“

This message is displayed at the end of a successful 
transfer when the file had to be renamed because 
a file already exists on the receiving handheld with 
the original name. The transmitted file is renamed 
by appending a number to the end of the name. 
Rename numbering always begins with (2) and can 
increment by one, as needed.

Sending handheld “<folder>/<filename> transferred as 
<folder>/<new filename>.“

This message indicates that a new folder was 
created on the receiving handheld to contain the 
transmitted document.

Receiving 
handheld

“<folder>/<filename(x)> received.“

This message indicates that the receiving handheld 
has a document with the same name as the 
document being sent. 

Receiving 
handheld

“<new folder>/<new filename> received.“

This message indicates that a new folder has been 
created to contain the transmitted document.

Receiving 
handheld

“Transfer failed. Check cable and try 
again.“

OK

This message indicates that the cable is not 
correctly attached to the receiving handheld’s link 
port. Remove the cable then reattach it and try the 
transmission again.

Click OK to cancel the transmission message. 

Shown on Message and Description
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Memory and File Management

The TI-Nspire™ CX Handheld comes equipped with 192 MB of memory. 
Of the total memory, 128 MB is dedicated to Flash storage and 64 MB is 
RAM. When the operating system is loaded, and as documents are 
created and stored on the handheld, memory is used and you may find 
that you need to free or restore memory after several months of use. If 
there is insufficient memory on the handheld, use one of the following 
options to restore space on the handheld:

• Delete documents and folders you no longer use.

• Back up files and folders to another handheld or computer.

• Reset the memory, which deletes ALL files and folders on the 
handheld.

Checking Available Memory
Complete the following steps to view the amount of memory (in bytes) 
used by all documents and variables on your handheld.

1. From the Home screen, select Status from the Settings menu.

Press c 5 4.

The Handheld Status window opens.

2. View the Available Space field to determine how much memory is 
available on the handheld.

3. Click OK to return to the Home screen.
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Freeing Memory
To free or recover memory, delete documents and/or folders from the 
handheld. To keep the documents and folders for later use, transfer them 
to another handheld or to a computer using the TI-Nspire™ software.

Deleting Files from the Handheld

1. Press c 2 to open the My Documents file browser.

2. Press £ or ¤ to select the folder or document you want to delete.

3. Press ..

—or—

Press / b 6.

A dialog box opens, asking you to confirm the deletion.

4. Press · to confirm or d to cancel.

The folder/document is permanently removed from the handheld.

Backing up Files to Another Handheld
1. Connect the two handhelds using the USB-to-USB connectivity cable.

2. Press c 2 to open My Documents on the sending handheld. 

3. Press the 5 and 6 keys to highlight the document you want to send.

4. Press b, and then select Send.

—or—

Press / b 2.

5. When the file transfer is complete, a message is displayed on the 
receiving unit.
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Transferring Files to a Computer
Use the TI-Nspire™ software to transfer files and folders from a handheld 
to a computer.

1. Connect your handheld to the computer using a standard A to mini-B 
USB cable.

2. In the TI-Nspire™ software, open the Documents Workspace.

3. In the Documents Toolbox, click  to open the Content Explorer. 

4. In the Computer pane, navigate to the folder in which you want to 
save the files.

5. In the Connected Handhelds pane, double-click the handheld name 
to view the folders and files on the handheld.

Computer pane

Connected 
Handhelds pane
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6. Select the file or folder you want to save to the computer.

• Click the file to select one file or folder at a time.

• To select all files on the handheld, select the first file in the list, 
hold down the Shift key, and then click the last file or folder in 
the list.

• To select random files, click the first file, and then hold the Ctrl 
key while selecting additional files.

Note: If you select multiple files, it is saved as lesson bundle (.tilb file).

7. Drag the files to the folder in the Computer pane.

—or—

Select File > Save as. 

The files are copied to the folder on the computer.

8. Verify that the files you need are available on your computer, and 
then delete the files from the handheld.

Note: Those using the TI-Nspire™ Teacher Software or the TI-Nspire™ 
Navigator™ Teacher Software can also use options in the Content 
Workspace to copy files from a handheld to a computer.

Resetting the Memory
Complete these steps only if you want to delete ALL files and folders on 
your handheld.

Caution: Before you reset all memory, consider restoring sufficient 
available memory by deleting only selected data. If you reset all memory, 
the pre-installed applications on your handheld will remain, but any 
applications that have been downloaded in TI-84 mode will be deleted.

1. After making certain you want to clear all files, press c 2 to 
open the My Documents file browser.
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2. Press b to open the context menu.

3. Select Delete All.

—or—

Press C. 

The Data Loss dialog box opens.

4. Click OK to confirm that you want to clear the handheld memory.
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Updating the Handheld Operating System

To take advantage of the latest handheld features and updates, 
download the latest operating system files from the Education 
Technology website (education.ti.com). You can update the operating 
system (OS) on TI-Nspire™ handhelds using a computer and the 
following software:

• TI-Nspire™ Teacher Software

• TI-Nspire™ Student Software

• TI-Nspire™ CAS Teacher Software

• TI-Nspire™ CAS Student Software

• TI-Nspire™ Teacher Navigator™ Software

• TI-Nspire™ CAS Teacher Navigator™ Software

In the classroom, you can use the TI-Nspire™ Docking Stations to 
upgrade the OS on multiple handhelds at the same time. 

You can also transfer the OS from one TI-Nspire™ handheld to another 
or from one TI-Nspire™ CX handheld to another. However, handheld 
operating systems are not interchangeable. You cannot transfer a CAS 
operating system to a non-CAS handheld and you cannot transfer a 
TI-Nspire™ handheld operating system to a TI-Nspire™ CX handheld.

What You Need to Know
• If there is not enough room on the receiving handheld for the 

upgrade, a message is displayed. For more information, See Memory 
and File Management. 

• OS upgrade operations do not delete user documents. The only time 
documents are affected by an OS installation is if the receiving 
handheld has a corrupted OS. In this situation, documents may be 
affected by OS restoration. It is a good practice to back up important 
documents and folders before installing an updated operating 
system.

Warning: Upgrading the operating system will delete all TI-84 
applications and files. Before installing an OS upgrade, you should use 
TI Connect to back up all TI-84 applications and files to a computer. You 
can copy them back to the handheld when the OS upgrade is complete.

Before You Begin
Before beginning an OS download, ensure that batteries are at least 25 
percent charged. 
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• To check the status of the rechargeable battery in TI-Nspire™ CX 
handhelds, press c 5 4 to open the Handheld Status dialog 
box.

• To check the status of both the rechargeable battery and the AAA 
batteries in TI-Nspire™ handhelds, press c54 to open the 
Handheld Status dialog box.

When in OS download mode, the Automatic Power Down™ (APD™) 
feature does not function. If you leave your handheld in download mode 
for an extended time before you begin the downloading process, your 
batteries may become depleted. You will then need to replace or 
recharge the batteries before downloading the OS.

Finding Operating System Updates
For up-to-date information about available OS upgrades, check the Texas 
Instruments website at education.ti.com. 

You can download an OS upgrade from the Texas Instruments website to 
a computer, and use a USB cable to install the OS on your TI-Nspire™ 
handheld. You will need an Internet connection and the appropriate USB 
cable to download the updates.

Checking for Handheld OS Updates
When using TI-Nspire™ software, you can quickly determine if your 
handheld OS is up to date when the handheld is connected to a 
computer. 

1. Open the TI-Nspire™ software and ensure the handheld is connected 
to your computer.

2. In the Documents Workspace, click  to open Content Explorer. 

3. In the Connected Handhelds pane, select a connected handheld.
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4. Select Help > Check for Handheld OS Update.

• If the operating system is current, the Check for Handheld OS 
Update dialog box opens indicating that the operating system on 
the handheld is up to date.

• If the operating system is not current, the dialog box contains a 
message indicating that a new version of the operating system is 
available.

5. To turn off automatic notifications, clear the “Automatically check for 
updates check box. By default, this option is turned on.

6. Click OK to close the dialog box.

Updating the Operating System
In the TI-Nspire™ software, you can select to upgrade the operating 
system on a connected handheld from the following workspaces and 
menus:

• In all versions of the software, you can select Help > Check for 
Handheld/Lab Cradle OS Update. Select a connected handheld in the 
Content Explorer to activate this option. If the OS on the handheld is 



96 Updating the Handheld Operating System

not current, the dialog box indicates that there is an updated version 
of the operating system. Follow the prompts to update the operating 
system.

• In all versions of the TI-Nspire™ software, you can use options 
available in the Documents Workspace:

– Open Content Explorer, select the handheld name, and then click 

 and select Install OS.

—or—

– Select Tools > Install Handheld/Lab Cradle OS.

• Those using teacher versions of the TI-Nspire™ software can use 
options available in the Content Workspace:

– In the Resources pane, right-click the name of a connected 
handheld, and then select Install Handheld/Lab Cradle OS.

—or—

– Select the handheld name in the Preview pane, click  in the 
Preview pane, and then select Install Handheld/Lab Cradle OS. 

—or—

– Right-click the handheld name and select Install Handheld 
OS/Lab Cradle.

Completing the OS Upgrade
When you select to update the OS on a handheld, the Select Handheld 
OS File dialog box opens.
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The file displayed for selection defaults to the file type required for the 
selected handheld.

1. Select the OS file:

• If you are upgrading a TI-Nspire™ CX handheld, select 
TI-Nspire.tco

• If you are upgrading a TI-Nspire™ CX CAS handheld, select 
TI-Nspire.tcc

• If you are upgrading a TI-Nspire™ handheld, select TI-Nspire.tno

• If you are upgrading a TI-Nspire™ CAS handheld, select 
TI-Nspire.tnc

2. Click Install OS to download the OS and update the handheld. The 
confirmation message “You are about to upgrade your handheld 
operating system. Any unsaved data will be lost. Do you want to 
continue?” is displayed.

3. Click Yes to continue. 

The Installing OS dialog box opens indicating the progress of the 
download. Do not disconnect the handheld.

4. When the download is complete, the Information dialog box opens 
indicating that the OS file has been successfully transferred to the 
handheld. You can disconnect the handheld.
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5. Click OK. 

The updated operating system is installed on the handheld. When the 
update is complete, the handheld reboots.

6. On the handheld, follow the prompts to:

• Choose a preferred language.

• Select a preferred font size.

7. When the Welcome screen opens, click OK. 

The Home screen opens.

Transferring the Operating System From Another Handheld
Note: You cannot transfer the OS on a TI-Nspire™ handheld to a 
TI-Nspire™ CX handheld and you cannot transfer the OS on a CAS 
handheld to a non-CAS handheld. The operating systems are not the 
same and are not interchangeable.

To transfer the OS from one handheld to another:

1. Ensure any open documents on the receiving handheld are closed.

2. Connect the two handhelds using a USB mini-B to mini-B USB cable.

3. On the sending handheld, select My Documents from the Home 
screen.

4. Press b, and then select Send OS.

On a TI-Nspire™ handheld, press b.

5. On the receiving handheld, the message, “You are receiving an OS 
Upgrade. Unsaved changes will be lost. Would you like to continue?“ 
is displayed along with Yes and No response buttons. Select Yes to 
receive the OS upgrade. 

• If Yes is not selected within 30 seconds, the handheld 
automatically responds with No, and the transmission is cancelled.
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• It is important to save and close all open documents before 
performing an OS Upgrade. Continuing with an OS Upgrade on a 
handheld with an open, unsaved document will cause the loss of 
that data. 

6. While the upgrade is in progress, the following messages are 
displayed on the receiving and sending handhelds:

• “Receiving OS. Do not unplug cable.”

• “Sending OS. Do not unplug cable.“

7. After the transfer completes, the sending handheld receives a 
completion message and you can unhook the cable. The OS is 
automatically installed on the receiving handheld. During the 
installation process, the “Installing OS <version number>” message is 
displayed on the receiving handheld.

8. When the installation is complete, the “OS <version number> has 
been installed. Handheld will now restart.” message is displayed. The 
restart is initiated. If the sending handheld is still attached to the 
cable, the successful transmission message remains displayed on that 
handheld’s screen.

Important:
• For each receiving handheld, remember to back up information as 

necessary and install new batteries.

• Be sure the sending handheld is on the Send OS screen. 

Updating the OS on Multiple Handhelds
In the classroom, use the TI-Nspire™ Docking Station to upgrade the OS 
on multiple handhelds at the same time.

In the teacher versions of the TI-Nspire™ software, you can transfer files 
from the computer to multiple handhelds from the Content Workspace. 
See Using the Content Workspace for more information about 
transferring files to connected handhelds.
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OS Upgrade Messages
This section lists the information and error messages that can be 
displayed on handhelds during an OS Upgrade. 

Shown on: Message and Description

Sending handheld “Receiver does not have enough storage 
space. Make <xxxK> available.“

This message indicates that the receiving handheld 
does not have enough memory available for the 
new OS. The space requirement is shown so you 
know how much memory must be cleared for the 
new operating system. Files can be moved to a 
computer for storage to free the necessary space.

Sending handheld “Receiver must change batteries before 
upgrading the OS.“

This message indicates that the batteries in the 
receiving handheld need to be replaced. Send the 
OS Upgrade once the batteries are replaced. 

Sending handheld “Receiver has a newer OS and cannot 
load this OS.“

OK

This message indicates that the receiving handheld 
has a newer OS version than the one being 
transmitted. You cannot downgrade an OS.

Sending handheld “Upgrade not accepted by receiver.“

OK

This message indicates that the receiving handheld 
refuses the upgrade. 

Sending handheld “OS has been transferred. 
You can now unplug.“

OK

This message indicates that the transfer is 
complete and it is safe to unplug the cable from 
the sending handheld.

Sending handheld “Sending OS. Do not unplug cable.“

This message, along with a progress bar, is 
displayed while the OS Upgrade is being 
transferred. 
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Both handhelds “Transfer failed. Check cable and try 
again.“

OK

The sending and/or receiving handheld is not 
properly connected. Reinsert the cable into each 
handheld, and then try the transmission again.

Receiving 
handheld

“You are receiving an OS Upgrade. Unsaved 
changes will be lost. 

Would you like to continue?“

Yes No

This message is displayed when an OS Upgrade is 
about to begin. If you do not select Yes within 30 
seconds, the system automatically responds with 
No.

Receiving 
handheld

“Receiving OS. Do not unplug cable.“

This message, along with a progress bar, is 
displayed while the OS Upgrade is being 
transferred.

Receiving 
handheld

“Installing OS.“

This message is displayed when the transfer is 
complete. It is shown to keep you informed of the 
handheld’s status.

Receiving 
handheld

“OS has been installed. Handheld will 
restart.“

OK

This information message displays briefly before 
the handheld automatically reboots. 

Receiving 
handheld

“Install was corrupted. Handheld will 
reboot. You will need to retry OS upgrade.“

OK

An error occurred during the transmission and the 
installation was corrupted. The handheld will 
reboot. After the reboot, reinstall the OS Upgrade.

Shown on: Message and Description
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Using Keyboard Shortcuts

Keyboard Shortcuts
Use the following keyboard shortcuts to perform common functions. You 
can also perform all shortcuts performed by selecting options from 
menus.

Getting Help

Open Hints / μ

Editing Text

Cut / X 

Copy / C 

Paste / V 

Undo / Z

/ d

Redo / Y

g d

Toggle approximate and exact results / ·

English: Change key to include appropriate accent 

Chinese: Insert character
;

Inserting Characters and Symbols in a document

Display character/symbol palette / k 

Underscore / _ 

Display math template palette t 

Backslash ( \ ) g p

Manual data capture point / ^

Clear / .

Caps Lock / g

Store / h
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Square brackets / (

Curly brackets / )

Display Trig symbol palette μ

Equals symbol =

Display pi symbols palette 
(p, à, q, and so on), 

¹

Display equality/inequality palette
(>, <, ,≠, ≤, ≥, and | ) 

/ =

Display marks and letter symbols palette 
(? ! $  ' " : ; _ \)

º

Square root / q

log / s

ln / u

ans / v

Managing Documents

Open document menu ~

Open document / O

Close document / W

Create new document / N 

Insert new page / I 

Select application / K

Save current document / S 
/»

Navigation

Top of page / 7

End of page / 1

Page Up / 9



Using Keyboard Shortcuts 105

Page Down / 3

Up a level in the hierarchy / £

Down a level in the hierarchy / ¤

Context menu for selection b

Extends selection in direction of arrow g Any 
arrow

Navigating in Documents

Displays previous page / ¡ 

Displays next page / ¢ 

Displays Page Sorter / £ 

Exits Page Sorter / 6

Switch between applications on a split page / e

Moves focus backward within page g e

Wizards and Templates

Add a column to a matrix after the current column g @

Add a row to a matrix after the current row @

Integration template g + 

Derivative template g - 

Math template palette  t or / ;

Fraction template / p

Modifying Display

Increase contrast / + 

Decrease contrast / - 

Power off / c 

Using Application-Specific Shortcuts

Select all in Notes or Program Editor / A
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Check syntax and store (in Program Editor) / B

Insert Data Collection console / D

Find (in Program Editor) / F

Hide/Show Entry Line (in Graph or Geometry)

Go To (in Lists & Spreadsheet, Program Editor)
/ G

Find and Replace (In Program Editor) / H

Insert math expression box (in Notes) / M

Open the Scratchpad »

Recalculate (in Lists & Spreadsheet) / R

Add Function Table (in Lists & Spreadsheet, Graph, and 
Geometry)

/ T

Group/ungroup / 4 / 

/ 6
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Appendix: Service and Support

Precautions for Rechargeable Batteries
Take these precautions when replacing rechargeable batteries:

• Use only the charger recommended for the cell or battery, or the one 
that was provided with the original equipment.

• Remove the cell or battery from the charger or alternating current 
adapter when not in use or being charged.

• Use of the battery in other devices may result in personal injury or 
damage to equipment or property.

• Do not mix brands (or types within brands) of batteries. There is a 
risk of explosion if a battery is replaced by the wrong type.

Disposing of Batteries
Do not mutilate, puncture, or dispose of batteries in fire. The batteries 
can burst or explode, releasing hazardous chemicals. Discard used 
batteries according to local regulations. 



108 Appendix: Service and Support

Texas Instruments Support and Service

For U.S. and Canada:

For General Information 

For Technical Support 

For Product (Hardware) Service
Customers in the U.S., Canada, Mexico, Puerto Rico and Virgin 
Islands: Always contact Texas Instruments Customer Support before 
returning a product for service.

For All Other Countries:
For general information 

For more information about TI products and services, contact TI by e-mail 
or visit the TI Internet address.

Service and Warranty Information
For information about the length and terms of the warranty or about 
product service, refer to the warranty statement enclosed with this 
product or contact your local Texas Instruments retailer/distributor.

Home Page: education.ti.com

KnowledgeBase and 
e-mail inquiries:

education.ti.com/support

Phone: (800) TI-CARES / (800) 842-2737
For U.S., Canada, Mexico, Puerto Rico, and 
Virgin Islands only

International 
information:

education.ti.com/international

KnowledgeBase and 
support by e-mail:

education.ti.com/support

Phone 
(not toll-free):

(972) 917-8324

E-mail inquiries: ti-cares@ti.com

Home Page: education.ti.com

http://education.ti.com
http://education.ti.com/support
http://education.ti.com/support
http://education.ti.com/international
http://education.ti.com/support
http://education.ti.com/support
http://education.ti.com
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A
adapters 76
adding

accents to text 51
applications 30
images 53
multiple applications to pages 32
pages to problems 42
problems 42

adjusting backlight brightness 5
applications

adding to documents 30
multiple on pages 32
swapping 34

attaching
wireless adapters 76
wireless cradles 77

auto dim
changing 66

Automatic Power Down™ (APD™) 3

B
backing up

files to another handheld 88
backlighting

adjusting brightness 5
batteries

disposing of 64
recharging 63
replacing 74

browsing files 44

C
cables, USB 79
Calculator history

clearing 17
copying items from 17
results 18
viewing 17

canceling, file transfers 82
caps lock 9
CAS (Computer Algebra System) 1
Catalog

inserting commands 48

inserting items from 15
opening 48
wizards 49

changing
auto dim 66
font size 66
Graphs & Geometry Settings 71
handheld settings 64
hibernate options 66
language 65
pointer speed 66
power standby 66

characters
international language 51
special 50

charging batteries 3
choosing

font size 4
language 4

class
logging in 57

classes
pausing 57

closing
documents 47
Scratchpad 12

common functions
keyboard shortcuts 103

communications, wireless 75
connecting

handhelds to computers 81
two handhelds 79, 80

copying
documents 47
folders 47

copying images 53
cradles 77
creating

documents 28
folders 46

customising
General Settings 67
Graphs & Geometry Settings 71
handheld setup 66
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D
default settings

changing General Settings 68
restoring General Settings 70

deleting
documents 46, 88
files 88
folders 46
images 55
memory 90

documents
closing 47
copying 47
copying pages to 40
creating 28
deleting 46, 88
managing 43
navigating 43
receiving 82
renaming 45
saving 29
sending to handhelds 82
structure 27
transferring 81

downloading OS files 93
drivers, USB 64

E
editing

math expressions 19
error messages 100

file transfers 85
sending folders 84

evaluating
math expressions 12, 14

expressions
copying from Calculator history 

18
editing 19
entering and evaluating 12
entering from a template 14
entering with a wizard 15
selecting in Calculator 19

F
files

backing up 88
canceling transfers 82
naming conventions 46
saving to handhelds 84
transferring 81, 82, 89
transferring to another 

handheld 81
folders

copying 47
creating 46
deleting 46
naming conventions 46
renaming 45
sending to handhelds 82

font size
changing 66
choosing 4

freeing memory 88

G
General Settings

customising 67
restoring 70

Graphs & Geometry Settings
changing 71
customising 71
viewing 71

H
handheld

details 73
keys 2
screen 8
settings 64
status 73

hibernate options 66
hints 10
history, Calculator 18
Home screen 6, 7

I
images

adding 53
copying 53
deleting 55
repositioning 54
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resizing 55
inserting

expression templates 13
functions and commands 13
items from Catalog 13
symbols 13
units 13

international language characters 
51

K
keyboard shortcuts 103
keys 2

L
language

changing 65
choosing 4
international characters 51

logging in to class 57
login status 59

M
math expressions 50

editing 19
entering and evaluating 12
selecting in Calculator 19

math templates 50
memory

checking 87
freeing 88
resetting 90

menu options 7
menus

application 35
context 36
Settings 65

moving, images 54
My Documents 44

N
naming files and folders 46
network adapters 75

O
opening

Catalog 13, 48
context menus 36
handheld status screen 73
hints 10
My Documents 44
Scratchpad 11
Settings menu 65

operating system
downloading files 93
finding updates 94
transferring 98
updating 93, 95

options, Home screen 7

P
page layouts

choosing 32
custom 33

page sorter 38, 43
pages 27

adding to problems 42
copying to another document 40
copying to another problem 39
reordering 38, 43
reordering in problems 39, 40

pausing classes 57
pointer speed, changing 66
power sources

batteries 64
connected computer 64
priority 64
USB cable 64
wall charger 64

power standby setting 66
Press to Test 9
problems 27

adding pages 42
adding to pages 37
copying 41
copying pages to other problems 

39
deleting 42
pasting 41
renaming 42
reordering 39
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R
receiving

documents 82
folders 82

recharging
batteries 63
batteries from a computer 64
handhelds 63

recovering deleted documents 47
removing images 55
renaming

documents 45
folders 45
problems 42

replacing, batteries 74
repositioning images 54
resetting memory 90
resizing images 55
restoring

General Settings 70
reusing

items from Calculator history 18

S
saving

documents 29
files to handhelds 84
Scratchpad contents 25

scrolling arrows 9
selecting

expressions in Calculator 19
selecting images 53
setting

handheld options 64
hibernate options 66
power standby 66

Settings & Status
General Settings 67
Graphs & Geometry 71

Settings menu 65
setup options 66
shortcuts, keyboard 103
status

login 59

T
tabs 9
templates 14, 50

math expressions 50
Touchpad 2, 5
transferring

documents 81
files from a computer 82
files to a computer 82, 89
files to another handheld 81
OS from another handheld 98
rules 81

U
updating handheld OS

before you begin 93
completing the update 96
multiple handhelds 99

USB
cables 79
drivers 64

V
variables 48
viewing

Calculator history 17
Graphs & Geometry Settings 71
handheld details 73
handheld status 73

W
wireless

adapters 76
attaching adapters 76
attaching cradles 77
communications 75
cradles 77
network adapters 75

wizards 15, 49
work areas 27, 32


	Important Information
	FCC Statement

	Getting Started with the TI-Nspire™ CX Handheld
	About CAS
	TI-Nspire™ CX Handheld Keys
	Preparing the TI-Nspire™ CX Handheld for Use
	Charging the Handheld

	Turning On the TI-Nspire™ Handheld for the First Time
	Using Automatic Power Down™
	Choosing a Language
	Choosing a Font Size

	Adjusting the Brightness of the Backlighting
	Using the TI-Nspire™ Touchpad
	Understanding the Scratchpad
	Using the Home Screen
	Home Screen Options

	The TI-Nspire™ Handheld Screen
	Using Hints

	Using the Scratchpad
	Opening and Closing the Scratchpad
	Calculating with Scratchpad
	Entering Simple Math Expressions

	Inserting Items from the Catalog
	Using an Expression Template
	Inserting Expressions Using a Wizard

	Viewing the History
	Copying a History Item to the Entry Line
	Clearing the History

	Editing Scratchpad Expressions
	Inserting Elements into the Entry Line
	Selecting Part of an Expression

	Graphing with the Scratchpad
	Viewing the Table
	Changing the Appearance of the Axes
	Tracing a Plot
	Finding Points of Interest

	Working with Variables in the Scratchpad
	Saving the Scratchpad Contents
	Clearing Scratchpad Contents

	Working with Documents on TI-Nspire™ Handhelds
	Opening a Document
	Creating a New Document
	Saving Documents
	Saving a Document in a Different Folder
	Saving a Document in a New Folder

	Working with Applications
	Adding an Application
	Using Multiple Applications on a Page
	Grouping Applications
	Ungrouping Pages

	Using the Application Menu
	Using the Application Menu

	Context Menus
	Using the Context Menu

	Working with Problems and Pages
	Adding a Problem to a Document
	Viewing and Reordering Pages in a Document
	Viewing Multiple Pages with the Page Sorter
	Opening the Page Sorter from a Document
	Reordering Pages in a Problem
	Copying a Page to Another Problem
	Copying a Page to Another Document

	Copying, Pasting, and Deleting Problems
	Copying and Pasting a Problem
	Deleting a Problem

	Renaming a Problem
	Adding a Page to a Problem
	Moving Through Pages in a Document
	Managing Documents
	Browsing Files in My Documents
	Renaming Folders or Documents
	Creating Folders
	File and Folder Naming Conventions
	Duplicating Documents and Folders
	Recovering Deleted Documents

	Closing a Document
	Understanding the TI-Nspire™ Tools
	Creating TI-Nspire™ Variables
	Using the Catalog
	Using Wizards
	Entering Special Characters
	Entering Math Expressions
	Entering International Language Characters


	Working with Images
	Working with Images on a Handheld
	Copying an Image
	Repositioning an Image
	Resizing an Image
	Deleting an Image


	Working in a TI-Nspire™ Navigator™ Teacher Software Classroom
	Pausing a Class Session
	Logging In to Class
	Connecting to the TI-Nspire™ Navigator™ System
	Logging in to the TI-Nspire™ Navigator™ Network
	TI-Nspire™ Handheld Login Status Icons

	Understanding File Transfers
	Opening Sent Files
	Collecting or Deleting Files


	Configuring Handhelds
	Checking Battery Status
	Recharging the Handheld
	Recharging a Battery from a Computer
	Understanding the Priority of Power Sources
	Disposing of Used Batteries Safely and Properly

	Changing Handheld Settings
	Opening the Settings Menu

	Changing a Preferred Language
	Customizing the Handheld Setup
	Changing Handheld Setup Options

	Customizing Document Settings
	Changing Default Document Settings
	Changing Document Settings in a TI-Nspire™ Document
	Restoring Document Settings

	Customising Graphs & Geometry Settings
	Viewing Handheld Status
	Opening the Handheld Status Screen

	Replacing TI-Nspire™ Rechargeable Batteries
	Using Wireless Communication Hardware
	Attaching a Wireless Adapter to a CX Handheld
	Attaching a Wireless Cradle to a Handheld


	Connecting Handhelds and Transferring Files
	Connecting Handhelds
	Using USB Cables
	Connecting Two TI-Nspire™ Handhelds with the Mini-USB Cable
	Connecting the TI-Nspire™ Handheld to a Computer

	Transferring Files to and from Handhelds
	Rules for Transferring Files and Folders
	Sending a Document or Folder to Another Handheld
	Receiving a Document or Folder
	Canceling a Transfer

	Transferring Files Between Computers and Handhelds
	Using the Save to Handheld Option

	Handling Errors Resulting from Sending Folders
	Common Error and Notification Messages


	Memory and File Management
	Checking Available Memory
	Freeing Memory
	Deleting Files from the Handheld
	Backing up Files to Another Handheld
	Transferring Files to a Computer

	Resetting the Memory

	Updating the Handheld Operating System
	What You Need to Know
	Before You Begin

	Finding Operating System Updates
	Checking for Handheld OS Updates

	Updating the Operating System
	Completing the OS Upgrade
	Transferring the Operating System From Another Handheld
	Important:

	Updating the OS on Multiple Handhelds
	OS Upgrade Messages

	Using Keyboard Shortcuts
	Keyboard Shortcuts

	Appendix: Service and Support
	Precautions for Rechargeable Batteries
	Disposing of Batteries

	Texas Instruments Support and Service
	For U.S. and Canada:
	For General Information
	For Technical Support
	For Product (Hardware) Service
	For All Other Countries:

	Service and Warranty Information


